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NO AP Special Meal eForm

How to Submit a GT Special Meal eForm

Procedure

In this topic you will learn How to Submit a GT Special Meal eForm.

Step Action

1. To streamline and automate special meals prior approval form, an electronic version
of the previously paper-based form has been developed. This e-form will allow
greater ease of use, more visibility into the whereabouts of the form, and electronic
workflow approvals.

2. NOTE: To access the special meals eform in PeopleSoft, an employee will need
security access assigned to their user profile. Please check with your departmental
Business Manager and/or the Accounts Payable Team for more information
regarding gaining access.

Roles and workflow assigned for Special Meals Forms:

1. Form Requestor (A REQUESTOR CANNOT APPROVE HIS/HER OWN
FORM)

2. Department level approval

3. Dean’s office approval

3. Must Dos:

* Please be sure to enter information into all required data fields.

* Attach a list of attendees with specific names and affiliation to the University is
required.

* Click SUBMIT; the eform will then enter the approval workflow designated by
your School/Administrative section.
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_ Menu « Search in Menu = 1‘:1 N & O i @
L

My Financials Home ~ 10f8 >

System Notifications LSU Speedtypel/Acctg Tag Loo...

PS9FSTRN Notice: PeopleSoft
Financials Training - Upgraded to
PUM51 for review and training ORACLE
documentation
This is a test instance for LSU
Health PS Financials. Last refresh
date: 2025-04-07

PEQPLESOFT

Step Action

4. Click the My Financials Home dropdown button to activate the menu.
v
5. Press the left mouse button and drag the mouse down the list.
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_ Menu -

Search in Menu [~ 1 Q N Q ﬂ E @

My Financials Home ~ 10f8 >
Asset Management
5 LSU Speedtypel/Acctg Tag Loo...
Projects & Receivables ESoft
fded to
General Ledger ining ORACLE
Lsu PEQPLESOFT
Procurement =St
GT eForms™ Homepage
©]
Q@
Step Action
6. Click the GT eForms Homepage link.
GT eForms™ Homepage
7. Click the NO AP Special Meal Form button.
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= Form Family Landing Page X  +

] 2% rcbb.psfslsuhscedu/psc/fsupg/EMPLOYEE/ERP/c/NUI_FRAMEWORK PT_AGSTARTPAGE_NULGBL?CONTEXTID...

[3 Other [ PeopleSoftinfo [J PeopleAdmin Solutions A~ Ac bat PeopleSoft Web Lau...

.

< GT eForms™ Homepage Spcl Meals&Entertainment Resi3tinancials UPG Rt QA 4 ¢

7| Landing Page Welcome to LSUHSC-NO Request for Special Meals and Entertainment eForm

% Add a LSUNO spcl MAE eForm

| Evaluate a SMAE Form eForm

5] Update a SMAE Form eForm

5] View a spcl MAE eForm

=! Q Search “";’ m q'_. ! q 4 1 o P

Step Action

8. Click the Add a LSUNO spcl MAE eForm button.

+| Add a LSUNO spcl MAE eForm
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= cForm (Fluid) X  +
] 23 rcbb.psfs.lsuhscedu/psc/fspat/EMPLOYEE/ERP/c/NUI_FRAMEWORK.P'

[3 Other [ PeopleSoftInfo [ PeopleAdmin E s BE HREnd usery ) A at PeopleSoft Web Lau...

£ GT eForms™ Homepage LSUNO SMAE ... Financials PAT Q O\ 4'.3

a

4 ) Add SMAE Request : request special meal Form ID 11612 (NEW)

Highlights Enabled: (__ Yes [ ) Current\«'alues[le -l

LSU

NEW ORLEANS
Request for Prior Approval of Special Meal

D Breakfast $18.00
Lunch $26.00

Dinner $45.00

Refreshment $5.50

Reception $8.00

“amounts are maximum allowable

Event Information

9:57 AM

m g 1 2 o) fm
- Q Search |4 = 10/30/2025

Step

Action

The Form ID and Status are displayed in the top right corner of the page. In this
example, the Form ID is 11612 with a Status of (NEW).

NOTE: If you save the form rather than submitting it, the Form ID and Status
will be useful when searching for the form.

Press the left mouse button and drag the mouse down to the desired location.
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= cForm (Fluid) X  +

c 23 rcbb.psfs.lsuhsced

o [3 PeopleAdmin

£ GT eForms™ Homepage LSUNO SMAE ... Financials PAT Q O\ 4'.3

4

Contact Information

Requestor Name Contact Name (Form ‘ ‘
(Form Entered By) Requested For)

Requestor Phone Contact Phone ‘ ‘

Requestor Email *Contact Email ‘ ‘

Event Details

How will LSUHSC pay for this Expense?

Event Information

Business Unit LSUNO

“DEPTID Q Department

RequestDate 10/30/2025 “EventDate 10302025  []

12:47 PM
10/30/2025

=! Q, Search

Step Action
10. Enter the desired information into the DEPTID field. Enter "1673200".
NOTE: The Department Name will be displayed when you navigate away from the
DEPTID field.
11. Users may click the calendar to search for the *Event Date or enter it directly into
the *Event Date ficld.
Click the Calendar button to choose the desired date.
|
12. Click the Next Month Arrow button.
>
13. Click the 4th for the *Event Date.
4
14. Enter the desired information into the Contact Name (Form Requested For) field.
Enter "Talesia Williams".
15. Enter the desired information into the Contact Phone field. Enter "225-354-4860".
16. Enter the desired information into the *Contact Email field. Enter
"twilll@lsuhsc.edu".
17. Press the left mouse button and drag the mouse down to the desired location.
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eForm (Fluid)

< GT eForms™ Homepage LSUNO SMAE ... Financials PAT Q O\ 4'.3

Event Details

How will LSUHSC pay for this Expense?

*Payment Type ~

Self-Funded event
(Continuing
education, student
activity funding

D sources)

*Justification- Why
is this event
scheduled?

=z
o

: Yes /\ Off-Campus [ No

On-Campus

Location Address

*Nacrriha niirnnza af ‘

“Event Title V‘

wr 11106 AM

g 1 & o)
& o
Br Q Search = ) oy 10/30/2025

Step Action

18. Click the button to the right of the *Payment Type field.

W

19. Click the Direct Pay reimbursement list item.

Direct Pay reimbursement

20. Enter the desired information into the *Justification - Why is this event
scheduled? field. Enter "Training Team Planning Meeting for PUM 51
upgrade".

21. Change the event from being On-Campus to Off-Campus.

Click the Off-Campus option.
1 No

22. Enter the desired information into the *Location Address ficld. Enter "Piccadilly
Cafeteria".

23. Enter the desired information into the *Location Address field. Enter "5179 Plank
Rd".

24. Enter the desired information into the *Location Address field. Enter "Baton
Rouge, LA 70805-3559".
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Step Action

25. Click the button to the right of the *Event Title field.

W

= eForm (Fluid) X o+

c 2% rcbb.psfslsuhscedu/psc/fspat/EMPLOYEE/ERP/c/NUI_FRAN

[ Other [ People Is m HREnd - Pt 3 t Web Lar
Faculty Interview

< GT eForms™ Homepageaet il LSUNO SMAE ... Financials PAT O\ 4'.3

Post Doc Interview

* Justification- Why Agency Hosted Conference PUM 51
is this event | symmer Program Event
scheduled?

Student Event LSUHSC p

Student Interview ———

On-Campus University Guest/Speaker Event Off-Campus {_ Yes [ )

Qrientation

Training Event

Grand Rounds(no-LSUHSC spkrs)

“Location Address

Other
EventTitle | v *Describe purpose of
the event and meal
type
4
Type of Meal
*Type of Request v

Attendee Count & Total Estimated Cost of Meal

g . 1126 AM
[ ] Q Search o

| | 10/30/2025

Step Action

26. Click the Other list item.
Other

27. Enter the desired information into the *Describe purpose of the event and meal
type field. Enter "Review module revision status and develop plan for
completion".

28. Click the button to the right of the *Type of Request field.

W
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= cForm (Fluid) X  +
] 25 rcbb.psfs.lsuhscedu/psc/fspat/EMPLOYEE/ERP/c/NUI_FRAMEWORK.P' oL * D

[3 Other [ PeopleSoftInfo [ PeopleAdmin E s BE HREnd usery ) A at PeopleSoft Web Lau...

£ GT eForms™ Homepage LSUNO SMAE ... Financials PAT Q O\ 4'.3

PICCADILLY CAFETERIA
5179 PLANK RD
BATON ROUGE, LA 70805-3559

“Location Address

Review module status and develop plan for

“Event Title ‘ Other ~| Other
e — completion

*Describe purpose of
the event and meal

type

Type of Meal

D *Type of Request ~

Blanket Approval

Attendee Count & To!
One Time Event

‘P:I:lmbelr of ‘1—‘

“Per Person Cost ‘1 00 ‘

Total Cost of the
Meal 000

12:00 PM

mm - T 2 o) g
P Q, Search | = 10/30/2025

Step Action

29. Click the One Time Event list item.

One Time Event

30. Press the left mouse button and drag the mouse down to the desired location.

W

31. Click the Lunch list item.
Lunch

32. Enter the desired information into the *Number of Attendees field. Enter "3".

33. Click the Employee option to Yes.
"] No I
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= cForm (Fluid) X  +

c 2% rcbb.psfs.lsuhscedu/ spat/EMPLOYI /c/NUI_FRAMEWORK.|

[3 Other [ PeopleSoftinfo [ PeopleAdmin Solu 2 HR End us

£ GT eForms™ Homepage LSUNO SMAE ... Financials PAT Q O\ 4'.3

4

Accounting Details

Accounting Tag & Description *ACCOUNT < DESCRIPTION Percent &

File Attachments
1 row

Tag ACCOUNT FUND
:I))E gT c PDE P§OGR

Q ~ 100.00

Attachment Required Upload Description & Description & File Name © Delete
1 o Upload Attendee List/Guest List Attendee List/Guest List Delete
Add
» Comments
. - | v

12:16 PM
10/30/2025

BB Q search [ 0

Step

Action

34.

Enter the desired information into the Accounting Tag field. Enter "0673200001".
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* eForm (Fluid) X  +

c 23 rcbb.psfs.lsuhsceduy, pat/EMPLOYE! NUI_FRAMEWORK.PT_, 3 _NUL x m)

[ Other [ PeopleSoftinfo [ PeopleAdmin Solutions m HREnd Ado obat PeopleSoft Web

< GT eForms™ Homepage LSUNO SMAE ... Financials PAT Q O\ 4'.3

Accounting Details -
ACCOUNT
Accounting Tag Tag Description < “ACCOUNT < DESCRIPTION Percent <
1 |0673200001 Q.| 488160511 PEOPLESOFT-ADM SUPP v 100.00
File Attachments
1 row
Attachment Required Upload Description © Description & File Name < Delete
Attendee List/Guest List Attendee List/Guest List Delete
» Comments
. Qs .

L12PM
=! Q Search

10/30/2025

Step Action

35. Click the Account list item.

W
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= cForm (Fluid) X  +

c 2% rcbb.psfs.lsuhscedu/psc/fspat/EMPLOYEE/ERP/c/NUI_FRAMEWORK.PT_ ARTPAGE_NUI.GE!

[3 Other [ PeopleSoftInfo [ PeopleAdmin Solutions @ HR End u S at PeopleSoft Web Lau...

£ GT eForms™ Homepage LSUNO SMAE ... Financials PAT Q O\ 4'.3

Accounting Details

ACCOUNT
Accounting Tag < Tag Description < “ACCOUNT < DESCRIPTION Percent <
1 |0673200001 Q, | 488160511 PEOPLESOFT-ADM SUPP v 100.00
543700
File Attachments 565300
565310 1 row
Attachment Required Upload Description < Description & File Name < Delete
1 o Upload Attendee List/Guest List Attendee List/Guest List Delete
Add
» Comments
c.... | v

4

114 PM
10/30/2025

BB Q search ; . EE-

Step Action

36. Click the Account list item.
543700

37. Press the left mouse button and drag the mouse to the right side of the page.
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= cForm (Fluid) X  +

c 25 rcbb.psfs.lsuhscedu/psc/fspat/EMPLOYEE/ERP/c/NUI_FRAMEWORK.P'

[ Other [ PeopleSoftinfo [ PeopleAdmin Solutions =8 HR End us
£ GT eForms™ Homepage LSUNO SMAE ... Financials PAT Q O\ 4'.3
1 row
ACCOUNT FUND
“ACCOUNT & DESCRIPTION Percent ¢ D-01  cope PROGRAM CLASS BU_PC ACT
P | 543700 | Food Supplies 100.00 111 54000 10105 LSUNO | + ‘ ‘ - |
D 1 row
Description < File Name < Delete
st |Attendee List/Guest List Delete

1:24PM

o . o) B
Br Q Search | ® 0 g 10/30/2025

Step Action

38. View the chartstring for the specified Accounting Tag.

Press the left mouse button and drag the mouse to the left side of the page.
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= cForm (Fluid) +

c 2% rcbb.psfs.lsuhscedu/psc/fspat/EMPLOYEE/ERP/c/NUI_FRAMEWORK.PT_ ARTPAGE_NUI.GE!

[3 Other [ PeopleSoftInfo [ PeopleAdmin 2 HREnd u ~ at PeopleSoft Web Lau...

LSUNO SMAE

nean FINANCIals PAT

£ GT eForms™ Homepage

ACCOUNT

Accounting Tag Tag Description < “ACCOUNT < DESCRIPTION
1 | 0673200001 Q.| 488160511 PEOPLESOFT-ADM SUPP | 543700 +| Food Supplies
File Attachments

D Attachment Required Upload Description < Description & File Name <
1 o Upload Attendee List/Guest List Attendee List/Guest List
Add

» Comments

[ ]
Br

Q, Search

@ Q

Percent <

100.00

1 row

Delete

Delete

A tan 1:25PM
b 10/30/2025

Step Action

39.

Click the Upload button.

Upload

You will search for a file to attach on the Desktop called TT Luncheon Attendees.
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= cForm (Fluid) X  +

C 23 rcbb.psfs.lsuhscedu

[ Other [ PeopleSoftinio [ PeopleAdmin Solutions @ HR End user . X Adob bat PeopleSoft Web Lau...
£ GT eForms™ Homepage LSUNO SMAE ... Financials PAT Q O\ -'.3
ACCOUNT
Accounting T N Percent <
File Attachment X

1 |0673200001Y Choose From 100.00

File Attachment I:|D I

My Device 1 row

D Amchment] ’ [ Delete
1 o LTI H Delete

Add

» Comments

javascript:documentgetElementByld(#ICOrigFileName?).clic...

— = = . ~ 1:27 PM
- Q Search : - 10/30/2025

Step Action

40. Click the My Device button.

41. The file name you are looking for is TT Luncheon Attendees.

Press the left mouse button and drag the mouse to the right side of the page.
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- LSUHSC > Desktop

>

Percent <

100.00

1 row

[ Delete

= rems £ Delete
Open | Concel |

» Comments

. p . o 1:37 PM
m L7 H s = ° ® ] = ol 10/30/2025

HE Q Search

Step Action

42, Click the TT Luncheon Attendees link.
L ,ﬂ TT Luncheon Attendees

43. Click the Open button.

Page 16




Training Guide
eForm

= cForm (Fluid) x4

C 23 rcbb.psfslsuhsce

[ Other [ PeopleSoftinfo [ PeopleAdmin PeopleSoft Web Lau...
£ GT eForms™ Homepage LSUNO SMAE ... Financials PAT Q O\ Q
s
Accounting N azto Percent <
| File Attachment x B
1 Choose From 100.00
File Attachment |
1 row
Amchment] [ Delete
D
1 @ L . Delete
b B TT Luncheon Attendees.docx B
Add : @ File Size: 13KB :
I I
L e oo e oo e - H
» Comments

1:44 PM
10/30/2025

BE  Q Search G 1 ) |

Step Action
44, Click the Upload button.
Upload
45. Click the Done button.
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cForm (Fluid) X  +

] 2% rcbb.psfslsuhscedu/psc/fspat/EMPLOYEE/ERP/c/NUI_FRAMEWORK.PT_ ARTPAGE_NUI.GE!

[ Other [ PeopleSoftinfo [ PeopleAdmin Solutions mw HR End u S & at PeopleSoft Web Lau...
£ GT eForms™ Homepage LSUNO SMAE Health Financials PAT Q Q [:L
ACCOUNT

Accounting Tag Tag Description < “ACCOUNT < DESCRIPTION Percent <
1 | 0673200001 Q,| 488160511 PEOPLESOFT-ADM SUPP | 543700 w| Food Supplies 100.00
File Attachments

1 row
D Attachment Uploaded View Description < Description & File Name < Replace
1 0 View Attendee List/Guest List | Attendee List/Guest List TT_Luncheon_Attendees.docx
Add

» Comments

1:47 PM
10/30/2025

BB Q search ; . EE-

Step Action

46. Verify the list details attendees' specific names and affiliation to the University.
Click the View button to view list of attendees.

Wiew
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cForm (Fluid) X  +

TARTPAGE NULGE.. ¥ £} | (&

] 2% rcbb.p: du/p: pat/EMPLOYEE/ERP/c/NUI_FRAMEWORK.P'

[3 Other [ PeopleSoftInfo [ PeopleAdmin E B HR End userw PeopleSoft Web Lau...

LSUNO SMAE . Financials PAT @ Q A

£ GT eForms™ Homepage

ACCOUNT

Accounting Tag Tag Description < “ACCOUNT < DESCRIPTION Percent <
1 | 0673200001 Q,| 488160511 PEOPLESOFT-ADM SUPP | 543700 w| Food Supplies 100.00
File Attachments
1 row
File Name < Replace

D Attachment Uploaded View Description < Description &

1 0 Attendee List/Guest List | Attendee List/Guest List TT_Luncheon_Attendees.docx

» Comments

1:48 PM

1] 2 o) by
B Q Search 4 = 10/30/2025

eForm

Step

Action

47.

Click the Downloads button.
b

et
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cForm (Fluid) X  +

C % rcbb.psfslsuhscedu/psc/fspat/EMPLOYEE/

NUI_FRAMEWORK

Oc 3 Peop tinfo [ PeopleAdmin Soluti m HREnd u

< GT eForms™ Homepage LSUNO SMAE ..

n TT_Luncheon_Attendees.docx
10 minutes ago

Accounting Tag & Tag Description & “ACCOUNT <

Full download history

1 |0673200001 Q| 488160511 PEOPLESOFT-ADM SUPP | 543700

File Attachments

View File Name <

Attachment Uploaded
'@

Add

Description < Description &

Attendee List/Guest List | Attendee List/Guest List

» Comments

=y

[ ]
|

Q Search p > ) iy

Replace

TT_Luncheon_Attendees.docx

1 row

1:58 PM
10/30/2025

Step Action

48. Select the appropriate file from the download list.

Click the TT_Luncheon_Attendees Open button.

u TT_Luncheon_Attendees (1).docx
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w | “) - ) %  TT_luncheon_Attendees - Protected View » Saved to this PC pel = a *
File Home Insert Draw Design Layout References Mailings Review View Help RefWorks - RCM  Acrobat |E\ %
r\/ﬂ PROTECTED VIEW  This file is being verified by Microsaft Defender Advanced Threat Protection. You can continue to read thi

Viewing a
You can only view this document. You do not have
permissions to edit it.
[[raining Team Luncheon Attendees
Talesia Williams Staff Director of PeopleSoft Training
Staff PeopleSoft Training Coordinator
Staff PeopleSoft Training Coordinator
v
Page 1of 1 23 words T Focus B - —F——+ 100%

11112 AM
*  4716/2025

= ) g

eForm

Step

Action

49.

If you receive this message, simply click the OK button to close the popup.

Click the OK button.

50.

If the list needs to be edited, click the Enable Editing button on your Browser.

Click the Close button.
b4

51.

Click the Submit button.
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= cForm (Fluid)

c 2% rcbb.psfslsuhscedu/psc/fspat/EMPLOYEE/ERP/c/NUI_FRAMEWORK.P RTPAGE_NULGB.. 3¢ o3 2

[3 Other [ Peopl [3 PeopleAdmin 2 HREnd u ~ at PeopleSoft Web Lau...

£ GT eForms™ Homepage LSUNO SMAE ... Financials PAT Q O\ 4'.3

4+ ) Add SMAE Request : Result

Form ID 11616 (Pending)

You have successfully submitted your eForm.

The eForm has been routed to the next approval step.

multiple approvers.

[ View Approval Route (Add Ad Hoc Approver)

D Transaction / Signature Log
Current Date Time Step Title User ID Description Form Action Time Elapsed

1 row

1 10/30/2025 2:05:38PM Initiated

Refresh Log

Submit

=y. Q, Search ‘ 1 2

& v b 205 PM
ol 107302025

Step Action

52. Once submitted, the eForm will enter the electronic workflow approval process. The

requester will receive confirmation stating the form has successfully been submitted
and routed for approval.

NOTE: Users will be able to access the View Approval Routes panel when using
the View a LSUNO SMAE eForm option on the Landing Page.

53. To determine where your form has been routed for approval:
click the View Approval Route button.

Click the View Approval Route (Add Ad Hoc Approver) button.
View Approval Route (Add Ad Hoc Approver)
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= View Approval Route x +

c 2% rcbb.psfslsuhscedu/psc/fspat/EMPLOYEE/ERP/c/NUI_FRAMEWORK.P RTPAGE_NULGB.. 3¢ m} 2

[3 Other [ PeopleSoftinfo [ PeopleAdmin E s =m HREnd user web PeopleSoft Web Lau...

S | Cancel View Approval Route

:_\+/'3 Ad Review/Edit Approvers (Pending)
Basic Stage
+G3FORM_ID=11616

You havl Pending

The eFo Start New Path

multiple; Basic Path
% Pending EY NotRouted
»
Multiple Approvers No Approvers Found
View A ZZAP_SPECMAE DEPTAPPR> | ¥ | zzAP_SPECMAE_FiscALDEANS

D Transactiq 1 row
Curr] %ed

1 10/30.

Refresh

Print

g . . 2:07 PM
=y. Q Search 1 [ 4 o) g

*  10/30/2025

Step

Action

54.

This panel shows that the form has been routed to the first Approver and has a Status

of Pending. It also shows that the form has not been routed to the second Approver
and it has a Status of Not Routed.

Click the Done button.

55.

Users may print a copy of the submitted form.

Click the Print button.

Print
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= Print Selection x +

c 2% rcbb.psfslsuhscedu/psc/fspat/EMPLOYEE/ERP/c/NUI_FRAMEWORK.PT_ ARTPAGE_NULGB... 3¢ ) (R

[3 Other [ PeopleSoftInfo [ PeopleAdmin 2 HREnd PeopleSoft Web Lau...

< GT eForms™ Homepage LSUNO SMAE ... Financials PAT Q O\ -'.3
/+/‘ Add SMAE Request : Result

Form ID 11616 (Pending)

You have successfully submitted your eForm.

The eForm has been routed to the next approval step.

multiple approvers.

Print Selection [ |
[ View Approval Route (Add Ad Hoc Approver) Report -
Name
D Transaction / Signature Log 1 row
rint
Current Date Time Step ;

Form Action Time Elapsed

1 10/30/2025 2:05:38PM Initiated

Refresh Log

Submit

=! Q Search

Step Action

56. Click the button to the right of the Report Name field.
'

57. Click the ZZAPSPCLMEAL list item.
Z/APSPCLMEAL

58. Click the Print button.

Print
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& ZZAPSPCLMEALpdf B ar

@ £} Adobe Acrobat: PDF edit, convert, sign tools

[ Other [ PeopleSoftinfo [J PeopleAdmin S 5 R End user - 3 PeopleSoft Web Lau...

£,  Altols Edit

Louisiana State University Health Sciences Center
AP Special Meal and Entertainment Request
Form ID: 11616

From Department:  PeapleSoft Admin Support Org Request Date:  2025-10-30
Department ID: Requester

Event Date | Function Location Off Campus__| On Campus
Now 4. 2025 | PICCADILLY CAFETERIA v N
5179 PLANK RD

BATON ROUGE, LA 70805-3558
Justication | Training Team Planning Meeting for PUM 51 upgrade

Event Title | OTH | Other ~ Review module status and develop plan for completion

Requesied  Talesia Willams
for:

Total Cost | Por Guest Cost | Meal Type Number of Guests

$75.00 25.00 L 3

Speediype | Account Dept Program | Class | Project Percent

3 54000 10105 100

By using Al Assistant, you agree fo the Generative Al User Guidelines
v

Q Search B i M - “» P 212 PM

10/30/2025

Step Action

59. Users will click the Printer icon to print the form request.

NOTE: This form, along with the list of attendees, must be printed and included
with LaCarte or Direct Pay documentation.

Click the Close tab button.
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o™} “2 00 T | ¥ °*THISISATEST GT EFORM * Farm SPCLMEAL - Your SMAE Request eForm 11616 is Approved - Message (...

File Message Help  Acrobat

X O 82 g8/ # =m0 O 0O 5% o

pel - a >

Your IT eForm 11616 is approved by
Request Date: 2025-10-30

Comments:

Page=G3SEARCH FL&Action=U&G3FORM ID=11616&G3FORM TASK=VWS

=y. Q Search

Delete  Report | Respond | Shareto Al Quick =~ Move = Tags  Editing Immersive  Translaste  Zoom Reply with Report  Adobe
- v - Teams = Apps | Steps~ ~ - - - - Scheduling Poll | Message ~ Sig
Report Teams Apps | Quic.. & language  Zoom Find Time Protection ~
*THIS IS A TEST GT EFORM * Form SPCLMEAL - Your SMAE Request eForm 11616 is Approved
N N 3 Repl | %5 Reply All ‘ Fi d s e
PS Financials Development | @ | ) eRy | O Reel 7 Fomwar ‘ ‘ el ‘ ‘_|
To © Thu 10/34 2PM

You can review the form from this link: https://rcbb.psfs.lsuhsc.edu/psp/fspat/EMPLOYEE/ERP/c/G3FRAME.G3SEARCH FL.GBL?

Step Action

60. Once the form has been approved, the requester will receive the email shown here.

NOTE: Select the hyperlink to retrieve the form.

61. Click the Home button.
62. This completes How to Submit a GT Special Meal eForm.

End of Procedure.
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